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Mary Clubwala Jadhav
(1908 - 1975)
Founder, Madras School of Social Work

Mrs. Mary Clubwala Jadhav, a woman with an in born instinct and insatiable thirst for service to humanity,
founded the Madras School of Social Work in 1952. Born in 1908 into a rich Parsi family, she was raised
strictly in the traditional way by her mother who taught her the values of caring and sharing. In 1926, she
was married to Mr. Nogi Clubwala who encouraged her to involve herself in social activities. She was a
regular visitor to Government approved schools and worked for the Red Cross. After the sudden demise
of her husband, instead of retiring into a shell, she decided to employ her time meaningfully and immersed
herself in social work with total sincerity and commitment.

In 1937, Mrs. Mary Clubwala was made the Honorary Secretary of the Guild of Service. In 1942, during
World War Il, Mrs. Clubwala founded the Indian Hospitality Committee and persuaded women from all
communities and walks of life to join in the effort to organize mobile canteens, hospital visits, diversional
therapy and entertainment programmes for the army. The victorious army presented her a Japanese
sword in appreciation of her tremendous efforts and Mrs. Mary Clubwala was called "the Darling of the
Army" by General Cariappa. After the war, her focus was oncea gain on the Guild of Service which became
a banyan tree that put out roots.

for various projects like health centres, bakery units, an adoption centre, family assistance schemes,
meals on wheels, rural development projects and a school for the deaf, to name just a few.

Mrs. Clubwala's concern for destitute children was responsible for starting the Seva Samajam Boys'
Home and Girls' Home in Adyar in 1950. These homes gained an international reputation as model institu-
tions. In 1954, through the joint efforts of the Guild of Service and Madras Rotaract Club, she was instru-
mental in starting Bala Vihar in Kilpauk, a school for mentally challenged children.

Perhaps Mrs.Clubwala's most significant contribution was establishing the Madras School of Social Work
realizing the need to facilitate easy access and appropriate practical learning for students interested in
social work in the southern region, as there were only three schools of social work in
India and all of them were located in the North. She visited various schools of social
work in the USA to learn about their functioning and finally her dream came true in 1952,

In 1941, she received the Most Excellent Order of the British Empire (MBE). She was
honoured by the International Council of Social Welfare with the "Outstanding Service
Award" at The Hague in 1972. She was awarded the Padma Shri, Padma Bhushan and
Padma Vibhushan by the Government of India for her exceptional services. On bth
February 1975, she breathed her last in Bombay after a surgery to fight cancer. Condol-
ing her death, the then Prime Minister Mrs. Indira Gandhi mourned that India had lost an
eminent social worker.

Today Madras School of Social Work stands as a testimony to her dedication, persever-
ance and will to avercome obstacles, which helped her realise her dream of starting a
school to train professional social workers.
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Madras School of Social Work

Madras School of Social Work, an Autono-
mous Institution established in the year
1952, is affiliated to the University of
Madras and is accredited by NAAC with an
A+ Grade. It is located in Egmore, Chennai,
the state capital of Tamil Nadu. The Institu-
tion is run now under the aegis of Society for
Social Education and Research (SSER), a
registered non-profit organisation. The
College has been rated the Best College for
Social Work Education in South India and
one among the top five Social Work Institu-
tions in India by India Today and Outlook.

Madras School of Social Work offers the

following academic programmes adopting

CBCS pattern as prescribed by the Tamil

Nadu State Council for Higher Educa-
tion and the University of Madras:

Under Graduate
Programmes

e  Bachelor of Social Work (B.S.W.)
e  Bachelor of Science in Psychology
(B.Sc. Psychology)

Post Graduate Programmes

Master of Social Work (M.S.W.)

Master of Social Work
(Disability & Empowerment)

M.Sc. Counselling Psychology
(M.Sc. CP)

M.Sc. Family Counselling (M.Sc. FC)

M.A. Human Resource Management
(M.A. HRM)

M.A. Human Resource & Organizational
Development (M.A. HR&OD)
M.A. Development Studies (M.A. DS)

e M.A. Social Entrepreneurship (M.A. SE)

+
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Research Programmes

e M.Phil in Social Work
e  M.Phil in Psychology
e Ph.Din Social Work

Advantages of

Diploma Programmes MSSW

@ Compact Green Campus

e Postgraduate (Hons.) Diploma in
Personnel Management and
Industrial Relations

Experiential Learning

j . Value Added C
Postgraduate Diploma in Human alle Added LoUrses

Resource Management

Vibrant Alumni Connect

Postgraduate Diploma in
Integrated Counselling

Earn while you Learn Opportunities

Field Work and Internships for
Professional Development

Diploma in Trans disciplinary

Research & Practice
Programmes relevant to Industry and

Society

Diploma in Integrated Mental
Health Care

e Diploma in Mental Well-being of
Vulnerable Children

Updated Contemporary Curriculum

Qualified Faculty Members

Adequate Infrastructure

Excellent Library

Exclusive Placement Office

+
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VISON

To be a global leader in education,

research and intervention in Social
Work and allied disciplines towards
transforming human potential into

A socially sensitive change agents for 4

sustainable development

MISSION

MSSW will create outstanding professionals who will provide Transformational Leadership in the
community and workplace

Through:

Q An experiential transformative process of education and practice oriented pedagogy
involving multi-disciplinary social sciences research.

Q Implementing community outreach in our core competency areas, need and
evidence-based community practice interventions and delivering training &
consultancy services to corporate, government and civil society organizations.

1% Playing an active role in advocacy & policy formulation and access to contemporary

knowledge resources.

+
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Undergraduate Programmes

» Bachelor of Social Work
» Bachelor of Science in Psychology

SELF-FINANCED

8.00 AM to 1.30 PM

3 years (Full-time)

A pass in Higher Secondary Examination (Academic or Vocational
Stream) conducted by Govt. of Tamil Nadu or an examination accepted
as equivalent by the Syndicate, University of Madras.

The upper age limit for admission to UG programmes will be 21
(Twenty-One) years as on 1st July 2023.

However, a relaxation of 5 years is permitted for Differently- abled as
per G.0.Ms.N0.239, S.W. dated 3-9-1993. SC/ST/ BC/MBC/DNC candi-
dates and women candidates may be allowed the age relaxation of 3
years beyond 21 years.

» Applications to the UG programmes will be enabled only after the publication of 12th
Standard State Board results. Candidates should apply within 10 days from the date of
publication of results.

» CBSE and other Board students can apply only after their respective Board results are
published. A few seats will be made available for the students from these Boards.

+
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Postgraduate Programmes

Master of Social Work

AIDED

8.00 AM - 1.30 PM

2 years (Full-time)

SELF-FINANCED

1.30 PM - 6.30 PM

Master of Social Work

Master of Social Work in Disability and Empowerment
Master of Science in Counselling Psychology

Master of Science in Family Counselling

Master of Arts in Human Resource Management

Master of Human Resource Management &

Organisational Development

Master of Arts in Development Studies (8.00 am - 1.30 pm)
Master of Social Entrepreneurship (8.00 am - 1.30 pm)

2 years (Full-time)

Graduate in any discipline with a minimum 3 years programme duration
or its equivalent (under the 10+2+3) pattern that fulfils the mandatory
requirements of 15 years full-time formal education from a recognized
University and approved by the University of Madras.

For MSC Counselling Psychology / Family Counselling the applicant
must be a graduate in Psychology/ Counselling Psychology/ Psycholo-
gy in Triple Major.

Age Criteria as per Government norms.

+
PROSPECTUS ¢ 2024 - 2025
+




+

Progr fered

+

Research Programmes

M. Phil. (Social Work) Ph.D. (Social Work)
AIDED AIDED

8.00 AM to 1.30 PM 8.00 AM to 1.30 PM
1 year (Full-time) Full-time/Part-time

Candidates having passed 2-year | As per the norms of the
P.G. Degree programme in Social University of Madras
Work under 10+2+3 or 11+1+2
pattern

M. Phil. (Psychology)

SELF-FINANCED

1.30 PM - 6.30 PM

1 year (Full-time)

Candidates having passed 2-year P.G. Degree Programme in
Psychology under 10+2+3 or 11+1+2 pattern

> Prospectus for M.Phil programmes will be made available in the month of July. (Subject
to University of Madras communication for continuing the Course)

»  Prospectus for Ph.D. Programme is available on the University of Madras
website.

+
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UNDERGRADUATE |
PROGRAMMES

(Affiliated to the University of Madras)




Bachelor of<SocialWork (BSW)

The three-year Bachelor programme in Social Work is a preparatory programme with a blend of theory and field
practice. The uniqueness of this programme is that students are exposed to experiential learning. The main
objective of the programme is to impart education and training in professional social work and enhance
students’ understanding of social issues through interdisciplinary perspectives.

Programme Pattern

SEMESTER | SEMESTER Il SEMESTER Il
> Language | (Tamil I/French I) > Language Il (Tamil Il/French II) > Language IIl (Tamil Ill/French II)
> English | > Englishli , > English Il
> . _ » Social Work Profession > ,
Introduction To Social Waork > Human Growth And Development Social Case Work
> Sociology > Field Work |l » Economic And Political Systems
> Field Work | » Soft Skills Il And Processes
> Soft Skills | > Non-Major Elective > Field Work I
> Basic Tamil — Il / Sustainable > .
» Non-Major Elective - Stress Tourism And Social Work Soft Skills Il
Management/Basic Tamil-| > NSS > Value Education
> NSS > Valug Added Course — Up cycling | > NSS
Textiles
SEMESTER IV SEMESTER V SEMESTER VI
> Language IV (Tamil IV/French IV) | > Community Organization and » Social Welfare Administration
> English IV Social Action » Women's Development Issues
» Social Group Work » Saocial Development and and Concerns
) > Research
> Psychology Social Work > Human Rights
» Field Work IV » Dimensions of Health > Field Work VI
» Soft Skills IV > Social Work With Senior Citizens | » Soft Skills VI
> Environmental Studies > Field Work V > Non-Major Elective
» NSS > Soft Skills V > Introduction To Work Force
wan / Management / Social
» Value Added Course — Waste > Disability / Disaster Management | 3. Entrepreneurship.
Management & Social > Study Tour (Mandatory for Course
Entrepreneurship Completion)
» Summer Internship » Value Added Course — Green
Entrepreneurship.

The programme content has core subjects and allied subjects. Field practicum is an integral part of the programme which
consists of lab sessions, observation visits, project field work, rural camp and concurrent field work that enable the students to
relate the theory learnt in the class to social settings. Each student is expected to undertake a project report on his/her area of
interest in the field of Social Work under the supervision and guidance of faculty members. The programme is designed in such a
way that it will impart essential soft skills to mould the overall personality of the students.

Scope of the Programme:

The knowledge and practical experience gained through the theory papers and field exposure will enable the graduates to move
easily into other postgraduate programmes like MSW, Public Administration, Development Management, Human Resource
Management, Economics, Politics, Journalism and Law. The programme also helps prepare the candidates for competitive
examinations. Employment opportunities are open in welfare and corporate settings for the graduates of this programme.

+
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Bachelor of Science«n Psychology (B.Sc Psychology)

The B.Sc.Psychology programme is designed to give an opportunity to those students who are interested in
studying human behavior and those who wish to pursue their higher studies in the different fields of psycholo-
gy. For this purpose, the programme is aptly designed comprising theory papers, laboratory experience and
field visits.

Programme Pattern

SEMESTER | SEMESTER I SEMESTER Il
> Language | (Tamil / French) > Language Il (Tamil / French) > Language IIl (Tamil / French)
» English | » English Il » English Il
» General Psychology — | » General Psychology — I » Social Psychology - |
» Biological Psychology » Developmental Psychology | » Developmental
» Introduction to Social Work » Fundamental Statistics in Psychology |l
» Basic Tamil | (or) Psychology » Research Methods
Non-Major Elective - Stress > Basic Tamil Il (or) » Environmental Studies
Management Non-Major Elective - » Soft Skills Il
» Soft Skills | Interpersonal Skills
» Soft Skills Il
SEMESTER IV SEMESTER V SEMESTER VI
> Language IV (Tamil / French) » Abnormal Psychology — | » Abnormal Psychology — I
» English IV » Counselling Psychology » Organizational Behaviour
> Social Psychology — Il > Case Study (Practical) » Psychological Testing
> Experimental Psychology (Practical)| > Elective — Sports Psychology (Practical)
» Consumer Behaviour & Marketing (or) Health Psychology » Elective — Career Psychology
> Extension Activities / NSS > Value Education (or) Forensic Psychology
> Soft Skills IV > Survey Research (Practical)

The Programme will ensure that students are exposed to various fields of psychology and psychological testing, field visits,
projects and hands-on experience. Students will be given a strong foundation in both theory and practicum components
throughout the three-year undergraduate programme. They will learn about research methods, experiments in psychology and
soft skills which will focus on communication and computing skills. Students are facilitated to attend at least one profession-
al conference and workshop during the programme of the study. The department strives to build in each student an all-rounded
personality.

Value added courses are introduced to students every semester to enrich their experiences in disciplines like Arts and Crafts,
Sign Language, Martial Arts etc.

Scope of the Programme:

The undergraduate degree will be an excellent preparation for a postgraduate programme in the different fields of psychology
such as Counselling, Clinical and Organizational Psychology and in related fields such as criminology, human resource manage-

ment, social work and so on.
+
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POSTGRADUATE
PROGRAMMES

(Affiliated to the University of Madras)




Master-af Soeial Work
(Aided & Self-Financed)

The MSW (Aided) programme is a flagship programme offered for more than seven decades in
MSSW. The objective of the MSW programme is to prepare candidates as professionals in Commu-
nity Development, Medical and Psychiatric Social Work and Human Resource Management. The
programme is aimed at developing in them skills, attitudes and values necessary for working with
people in different community and organizational settings. In addition to imparting discipline and
specialization related knowledge, the programme will instill the values and attitudes required for
interpersonal and managerial skills necessary for effective practice.

The programme is offered in both Aided and Self-Financed streams. Though the curriculum remains
the same, the class timings, academic calendar and administration are distinct.

The first and the second semester courses are generic social work courses. Semester Il & IV are
purely specialization centric., MSW has a robust and rigorous curriculum to impart the knowledge,
values, skills and attitudes required for the profession. The curricular inputs are offered as core,
interdisciplinary, elective and programme completion courses. One of the highlights of the
programme is field work. The field work curriculum is graded and is progressive in nature in terms
of its goals and scope across semesters.

SPECIALIZATION DETAILS:

Community Development (CD) : This specialization equips the students to work with communities
based issues. Focusing on micro and macro-practice in Social Work, this specialization provides
students with skills to identify the needs of rural, urban and tribal communities, plan interventions,
mobilize communities, manage development projects, monitor and evaluate programmes, build
capacities of communities and organizations and advocate for human rights. Employment opportu-
nities are available with Government departments, National and International NGO's, UN Organiza-
tions and in CSR Departments of the corporate sector besides the option to launch their careers
as Social Entrepreneurs.

Medical & Psychiatric Social Work (MPSW): This specialization helps students to understand the
physical and mental health needs of individuals and families and equips them to intervene at the
personal and community levels. Students are trained and exposed to psycho-social assessments,
therapies, counselling and health systems and they become competent in planning and implement-
ing family and community health interventions. Students completing this specialization can gain
employment in Government and Non-Government organizations, hospitals, mental health centres,
individual and family counselling centres, community health, UN Organizations, CSR departments
and research institutions.

Human Resource Management (HRM): This specialization trains students to become socially
relevant and competent Human Resource Managers. Along with cutting-edge knowledge on all
aspects of HRM, students are also imparted strong people skills and values. Students who gradu-
ate with this specialization in Social Work will have better adaptability, problem-solving and
team-building skills. Employment opportunities are available in the HR and L&D departments, the
corporate sector and National and International NGOs. Candidates who have completed this
programme are also eligible to be appointed as labour welfare officers.

+
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Master-of Social Work

(Aided & Self-Financed)

Children and Families (CF) (Offered only in Self Financed): In recent years, the globalised world has been
witnessing significant civil society engagement on issues connected to children and families. The forces of
globalisation place over highly unfair social and economic institution is driving women and children and vulner-
able families into child labour, sex work or other forms of exploitative relationships. The programme provides
students with a critical understanding of the diversity of childhoods and families, along with diverse context
for individual development, as well as of policies, legislations and macro developmental processes impacting
children and families. Students in this programme will have developed their capacities to understand rights
based work for ensuring inclusion of children of marginalised communities and their families into the main-
stream processes of development, while being trained in skill- based intervention as well.

*Under approval by University of Madras

Mental Health (MH) (Offered only in Self Financed): This specialization is offered in collaboration with Banyan
Academy of Leadership in Mental Health (BALM). BALM strives to bridge treatment and care gaps through
research, social action and education, to build effective and ethical leadership in the mental health sectors
for vulnerable populations. The programme aims to provide the learners a sound base’in the field of mental
health through an in-depth study into mental wellbeing, mental illness, mental healthcare, social determi-
nants of mental health and other related concerns. It is a unique competency building programme for students
to address the pressing and crucial needs of mental health and wellbeing. The programme will benefit the
mental health sector by increasing the availability of trained mental health social work professionals in
various set ups ranging from primary health care centres, government hospitals and clinics to non-govern-
ment organisations, hospitals and centres. Need based scholarships for this specialization are supported by
Sundram Fasteners Limited.

*Under approval by University of Madras

Programme Pattern

YEARS SEMESTER | SEMESTER Il
» Social Work Profession » Social Work with Communities
» Saocial work with Individuals » Social Research and Statistics
> Social work with Groups > Social Policy & Legislation (CD & MPSW)
> Sociology » Human Resource Management (HR)
FIRST YEAR > Psychology > Basics of Counselling /Corporate Social
» Field Work | Responsibility for Sustainable
» Soft Skills | - Personal and Interpersonal Development Management of
Connect Organizations
» Field Work Il
» Soft Skills 1I- Ability Enhancement Course

+
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Master-af Soeial Work
(Aided & Self-Financed)

Il YEAR
SPECIALIZATION SEMESTER Il - PAPERS SEMESTER IV- PAPERS
» Rural Development and Governance » Urban Development and Governance
COMMUNITY » Dalit and Tribal Empowerment » Social Work with Children & Youth
DEVELOPMENT » Community Development - Community Health
(CD) Approaches and Tools > Social Entrepreneurship or
» Women and Development » Disaster Management & Environmental
Social Work (CD/MPSW/HR)
» Mental Health and Psychiatric Social Work | > Clinical Social Work
MEDICAL & » Medical Social Work » Therapeutic Interventions in Social Work
PSYCHIATRIC » Community Development - Approaches and | » Community Health
(MPSW) Tools > Disability and Social Work
» Social Work with Families and Senior » Disaster Management & Environmental
Citizens Social Work (CD/MPSW/HR)
» Labour Legislation - | » Organizational Change & Development
HUMAN > Strategic Human Resource Management > Learning & Development
RESOURCE > Organizational Behaviour > Labour Legislation - Il
MANAGEMENT | » Employee Relations & Welfare > Performance Management & Compensation
(HRM) Management (HRM)
» Disaster Management & Environmental
Social Work (CD/MPSW/HR)
» Introduction to Children and Families » Social Work with Children
CHILDREN AND > Chilq Development and Childhood Disorqers > Gerontological Social Work -
FAMILIES (CF) » Family Dynamics and Social Work Practice | » Therapeutic Approaches and Interventions
» International and National Frameworks for | > Social Entrepreneurship
Children
» Introduction to Mental Health » Social Work Practice in Mental Health
MENTAL » Child Development and Childhood Disorders Settings
HEALTH (MH) » Public Mental Health. » Mental He_alth and Marginalization :
» International and National Frame works » Therapeutic Approaches and Interventions
for Mental Health » Psycho Social Rehabilitation

COMMON TO ALL
SPECIALIZATION

> Field Work Il &IV Block Pattern

» Research Monograph —Ill Semester & Research Projects —IV Semester

Ability Enhancement Course

> |l Semester - Leadership & Team Building
» |V Semester Specialization Competencies
Participation in Professional Forum Activities

+
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Value-Added»Course

MSW (Aided)

Development Communication

Human Rights

Psychiatric Assessment and Therapeutic Counselling
Expressive Art Therapy

Human Resource Information Systems & Analytics
Advanced Counselling Skills

Corporate Social Responsibility & Social Audit

HR Compliance

Community Health

Six Sigma

Business Acumen Skills

Psycho- Social Rehabilitation

VVVVVVYVYYVYVYVYYYY

MSW (Self Financed)

Human Rights

Palliative Care

Finance for Non-finance Professionals
Business Communication

NGO Governance, Finance & Legal Compliance
Micro-Finance for Inclusion

Design Thinking

Talent Acquisition

Neuro-Linguistic Programming
Transaction Analysis

HR Analytics

Project Planning and Formulation

VVVVVVYVYVYVYVYYVYYY

Note:

¢ Functional knowledge of Tamil is mandatory as per university regulations.

e Specializations will be allotted at the time of admission on the basis of application submitted.
¢ No change in specialization will be permitted after admission.

e Specialization are only in the second year of the programme.

e Field Work in community and organizational settings is a mandatory part of the program.

+
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Master-oef Social Work

(Disability and Empowerment)

Master of Social Work in Disability & Empowerment is professional course that is aimed at grooming leaders with the
required knowledge, skills, competencies and values towards empowering Persons with Disabilities. This is strategically
achieved through the curriculum by understanding and promoting inclusion, accessibility and ensuring opportunities for
the target group through experiential learning and field work exposure. The course is focussed on capitalizing the grow-
ing scope and opportunities that exists both in the government and private sectors. The department nurtures profession-
al social workers characterised by professional competencies, strong theoretical foundation with practical exposure,
democratic values and high ethical standards.

The First-year subjects cover the generic social work methods and practices and in the Second year offer an in-depth
knowledge on the 21 types of disabilities recognised by the Government of India under the RPWD Act, 2016 and their
rehabilitation process. The curricular inputs are offered as core, inter-disciplinary and elective courses with a major
focus on field work. Ample opportunities are provided for students through filed work exposure, workshops, skills train-
ings and the Aroha Student's Forum for students to learn and develop themselves as season professionals with the right
attitude and value framewaork.

Programme Pattern

SEMESTER | SEMESTER I SEMESTER Il SEMESTER IV
» Social Work Profession » Social Work with Specialization Paper—-1 Specialization Paper—-5
> Social Work with Communities » Introduction to Disabilities | > Mental Disabilities and
Individuals » Social Research and Social Work Interventions
» Social work with Groups Sta‘glstlcs. Spemallz'atlon.Pap.e'r—.Z e
\ » Social Policy & » Physical Disabilities and | Specialization Paper—6
> Sociology Planning Social Work Interventions | > Counselling and Guidance
> Psychology > Basics of Counselling/ for Persons with Disability
» Field Work | Corporate Social Specialization Paper—3
> Ability Enhancement Responsibility for » Rehabilitation for Persons | Specialization Paper—7
Course-| Sustainable Development with Disabilities » Gender Perspectives of
» Management of Disability
Organizations Specialization Paper—4
» Social Legislation » Community Development | Interdisciplinary Paper
> Field Work Il Approaches and Tools » Social Entrepreneurship/
> Ability Enhancement » Research Monograph Environmental Social Work
Course -l > Field Work - 1l » Research Project
> Summer Internship (Block |> Ability Enhancement > Field Work - IV
Pattern) Course - lll » Ability Enhancement
» Professional Forum Course-IV
Activities - | » Participation in
Professional Forum
Activities - Il

Scope of the Programme

The students will gain skills and competencies required for identification, assessment and developing effec-
tive interventions for rehabilitation of persons with disabilities. Students' capacity will be built related to man-
aging projects, research, policy and advocacy, so as to ensure accessibility and inclusion of persons with disa-
bilities in different spheres of society. Employment opportunities are accessible with Government Depart-
ments, Regional, National NGOs and International Development Agencies, Special Schools, Care Homes,
Research Institutions and CSR Projects.

+
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Master-aef Social Work

(Disability and Empowerment)

Value Added Courses

1. Pain and Palliative Care for All Age Groups
2. Access Audit

3. Project Planning and Formulation

4. Social Innovation and Leadership

Entrance Test Question Paper Pattern for all MSW Programmes

SNO COMPONENTS MARKS
L General Aptitude 10
2. Quantitative Aptitude / Data Interpretation 10
3. Reading Comprehension / Verbal Ability 10
4. Social Awareness 10
5. Current Affairs 10
Total 50

+
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M.Sc Counselling:Psychology

M.Sc. in Counselling Psychology is a two-year full-time programme spanning four semesters. The programme aims at
equipping students with the knowledge and skills necessary for contributing to holistic development. The curriculum
highlights the combination of theory and practice in a balanced manner to build the competence of students in various
settings as Professional Counsellors. The students of this Programme are taught through various innovative methods.
Students are trained to administer, interpret and write reports on various psychological tests. Students must attend at
least two conferences/workshops during the course of their study. Students are also encouraged to present papers at
conferences and seminars and to publish their articles in national and international journals.

Programme Pattern

SEMESTER | SEMESTER |l SEMESTER IlI SEMESTER IV
» Cognitive Psychology » Research Methodology » Counselling Across Life » Counselling and Therapy for
» Counselling Process and | > Behaviour Modification Span Groups and Special
Skills » Psychological > Internship Populations
» Theories of Personality Assessment-| (Practical) |» Counselling and » Psychological Training
» Psychopathology » Case Analysis - | Praxis of Therapeutic Techniques Modules (Demonstration)
» Cross-Cultural Psychology Counselling » Psychological > Dissertation
» Health Psychology » Corporate Counselling Assessment - Il (Practical) | > Case Analysis - Il Praxis of
» Organizational Behaviour | > Life Skills » Counselling Children with Counselling
> Soft Skills -l » Organizational Behaviour Developmental Disorders | > Counselling in Schoals
> Soft Skills -lI > Positive Psychology > Soft Skills -IV
» Summer Placement » Training and Development
> Soft Skills Il

Scope of the Programme

The programme will prepare the students to launch themselves in an expanding professional world as consult-
ant psychologists, school/college counsellors, corporate counsellors and trainers, therapists, resource
persons, facilitators, Coach, instructors and teachers. They can pursue higher studies in Research, Advanced
psychology, Counselling Psychology, Clinical Psychology, and Psycho-Oncology.

Value Added Courses

M.Sc. CP M.Sc. CP
» Rehabilitation Psychology » Transactional Analysis
» Marital Therapy » Pre-marital and Couple Counselling
» Psychodrama » Integrated Therapeutic Technigues
» Expressive Art Therapy » Childhood Disorders - Assessment and Counselling
» Cognitive Behavioral Therapy » Yoga and Psychotherapy
» Art Therapy » Family Therapy
» Tobacco Cessation Methodologies » Dialectical Behaviour Therapy

> TAT-101

+
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M.Sc. Family Counselling

Family Counselling is a two-year postgraduate programme specifically designed to cater to the growing needs and
concerns in family dynamics and related domains. This programme will equip the students to use various counsel-
ling skills to enhance family functionality and relationships in various professional contexts and pursue careers
related to this.

Programme Pattern

Family & Relationship

: Theoretical Foundations Practicum
Counselling
» Basics of Family Therapy » Theories of Personality Counselling | » Psychological Assessment - | & Il
Relationship Counselling for » Children With Developmental Case Analysis - Praxis of
Children and Young People. » Disorders Training and Development Counselling - 1 & Il
» Family Therapy - Applications » Life Skills » Summer Internship
» Family Law and Legal Aspects » Behaviour Madification. » Concurrent Internship
» Dynamics in Parenting » Psychological Training Modules.
» Counselling for Couples
Counselling Skills Diagnaosis & Treatment Research Skills
» Counselling Process and Skills » Psychopathology » Statistics in Behavioural Sciences
» Counselling and Therapeutic » Addiction Counselling » Research Methodology Dissertation
Techniques » Counselling Children With
» Counselling and Therapy for Groups Developmental Disorders

and Special Populations

Highlights of the Programme:

The M.Sc. Family Counselling programme offers a rich blend of interdisciplinary learning, with courses covering
training and development, and familial law. Students engage in practical experiences such as outbound training (
0BT) and Study Tour to enhance their understanding. A comprehensive 300-hour supervised internship (summer and
Concurrent) is integrated into the curriculum, providing real-world exposure and skill development. Additionally,
value-added courses on Positive Psychology, Acceptance and Commitment Therapy, and Gerontology enrich the
learning experience have been offered previously. Soft skills training focuses on interpersonal communication,
academic writing, using statistical softwares like SPSS and career-oriented skills also o ered .In addition, students
have the opportunity to present and publish research papers. A highlight of the programme is a visit to a Family
Court, offering invaluable insights into the practical aspects of family counselling. Notably, the programme has
achieved a remarkable 70% placement rate for the batch 2022-2024 before course completion.

Scope of the Programme:

Graduates of the MSc Family Counselling programme are equipped for diverse career paths such as Family Counsel-
lors, Psychologists, Teachers, Lecturers, Elder Care Specialists, Rehabilitation Counsellors, School and Career
Counsellors, and Educational Psychologists. They can also pursue further education or transition into roles in
Human Resources (HR), social and service sectors like family welfare. The programme prepares individuals to
address the complex needs of families and individuals, offering a solid foundation for a range of professions focused
on promoting well-being and supporting individuals through various life challenges in families
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Entrance Test Question Paper Pattern for M.Sc. CP & M.Sc. FC

S.NO COMPONENTS MARKS
1 Language, Numerical and Reasoning — 20 questions 20
2. Psychology — 10 questions 10
3. Counselling Psychology - 10 questions 10
4. Research Aptitude — 10 questions 10
Total 50
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M.A Human Resourge Management (M.A. HRM)

Master of Arts in Human Resource Management programme was founded with conscientiousness, innovation and excel-
lence as our core values. It offers an unique academic programme for producing competitive managerial talent which has
gained ample corporate recognition over the years. In keeping with the vision of MSSW, the programme strives to mould
strategically equipped and socially sensitive business leaders. Producing top caliber HR Executives & 0D Practitioners
who meet the demands of the times has been the mission of the department. In the last 17 years, the programme has
grown from strength to strength producing highly placed professionals who have brought us laurels.

Programme Pattern

SEMESTER | SEMESTER |l SEMESTER Il SEMESTER IV
» Introduction to Business|>» Learning and » Employee Relations and | > Organizational Change
Management Development Welfare and Organizational
> Organizational Behaviour > Labour Law - [l > Psychqlogy at Workplace Development'
, » Total Rewards & » QOperations Management | > Entrepreneurial
» Strategic Human Performance » Industry-Institute Development
Resource'Management Management System Interface Il » International HRM
» Labour Law - | » Design Thinking & Agile |>» Research Project » HR Analytics
> Managerial Economics Project Management > Soft Skills Il » Human Resource
> Research > Qutbound Training Information System(or)
» Corporate Governance & . A
. - » Methodology Marketing Decisions in
Social Responsibility > Fi | Concents for HR
(or) Industrial Sociology nancia P :
Human Resource > Soft Skills IV
> Soft Skills | Manager (or) Fundamen > Student Social
> Observational Visits tals of Marketing Responsibility
Management Initiative (SSR)
» Industry-Institute
Interface |
> Soft Skills Il
» Summer Placement

Scope of the Programme

Keeping in mind the demands of the industry, this programme is designed to create HR Specialists to devel- op and
manage harmonious relationships at the workplace and to strike a balance between organizational and individual goals.
Students completing M.A. HRM are preferred by corporate houses for the positions of HR, Trainer, Recruiter, Welfare
Executive, and so on.

Value Added Courses
1. Social and Emotional Learning 2. HR Analytics
3. Labour Law and Employee Relations 4. Psychology at Workplace

5. Basics of Financial Markets & Personal Financial Planning

A platter of teaching methods is adopted besides classroom lectures, which includes group discussions, seminars,
dipstick studies, role-plays with audio-visual aids, skill labs and other simulation-based training methods. A committed
faculty base familiar with the system and capable of sharp classroom delivery is the strength of the department. Their
invalvement in industry-driven projects and consultancy is manifested in the classroom teachings. The Industry-Institute
Interface Programme aims to broaden the students' perspective by providing an exposure to the organizational environ-
ment, there by assisting them to relate HR Management theory with practice. e department also exposes the students
to interact with industry experts through guest lectures, workshops and panel discussions.
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M.A Human Reseurce and
Organizational Development (M.A. HR & 0D)

The programme was started in the year 2011 and is the second department in India to offer PG course in HR & QD after
Tata Institute of Social Sciences, Mumbai. Students are specialized in Human Resources and Organizational Develop-
ment. The department is equipped with the highly qualified faculty members who publish various research papers in
reputed journals and undertake consultancy projects for corporates in the field of HR. The curriculum is relevant and
updated based on industry expectations and new innovations happening in the field of HR & 0OD. The USP of the
programme is Industry Institute Interface which is mandatory for the students to do internships in reputed organizations.
It bridges classroom theory with corporate experience. The curriculum also paves way to students to undertake a
research project. The commitment and hard work make the students to get placed in reputed organizations in a high
number every year. Students are trained as per the requirement of industry during their two-year itself which makes them
industry ready every year.

Programme Pattern

SEMESTER | SEMESTER |l SEMESTER Il SEMESTER IV
» Strategic Human » Learning & Development | > Organizational » Organizational
Resource Management |> Industrial Relations Development-| Development-|
> Organizational Behaviour » Research Methodology |>» Operations Management | > International Human
o and Statistics » Performance Resource Management
> Management Principles » Change Management Management and » Human Resource
> Labor Legislation » Managerial Economics Compensation System Accounting and
» Fundamentals of > Project Management(or) [> Research Project Information systems
Accounting and Financial] ~ Business & Commercial |3 Industry-Institute > Industrial Psychology
Management Law Interface 11 > Entrepreneuri?l )
. . » Industry-Institute » Soft Skills lll Development (or
a Eijgﬁ;ﬂgs (or) Interface | » Qutbound Training Industrial Health,
» Soft Skills Il Hygiene & Safety
> Observation Visits » Summer Placement > Soft Skills IV
> Soft Skills | » Student Social
Responsibility

Scope of the Programme

The programme gives a special emphasis in creating vibrant HR & 0D professional to cater the needs of industry. The
holistic designed curriculum with Observation visits, Internships, out bound training and research project work will make
the students to demand the job in the market rather than searching the job. The industry connect of this programme will
make the student as an experienced HR & OD professional during the programme duration itself. The students are also
given soft skills training for all the four semesters by industry people in which they are trained in managerial and leader-
ship capability. The Department also has a student forum Bhavishya which organizes various Guest lectures, Workshaops,
Innovative student and Corporate Events.

Value Added Courses
1. Transactional Analysis 2. Six Sigma
3. HR Analytics 4. Neuro- Linguistic Programming
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Entrance Test Question Paper Pattern - M.A. HRM and M.A. HR & 0D

SNO COMPONENTS MARKS

1. General Aptitude 10

2. Quanitative Aptitude / Data Interpretation 10

3. Verbal Ability

4. Current Affairs

) Management & Human Resource (Fundamental Concepts) 20
Total 50
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M.A. Development Studies

This is a unique programme to meet the increasing demand and need of the various stakeholders at different levels in
the development sector. The students are sensitized and capacitated and given right exposure to face the challenges in
the contemporary society. This programme equips the students to understand their roles and responsibilities from higher
studies to employment opportunities from the regional level to global level.

Programme Pattern

SEMESTER | SEMESTER |l SEMESTER IlI SEMESTER IV

» Introduction to » Development Economics | » Data Analysis » Labor & Development
Development Thought | > Poverty, Inequalityand |> Gender and Development | > Sustainable

» Indian Society Sacial Exclusion » Urbanization and Development &

» Principles of Economics|>» Social Research— Development UNSDG's 2030

» Establishing & Managing|]  Theory & Methods » Social Entrepreneurship | > Public Policy
Development > Project Management(or) (or) Disaster > International
Organizations (or) Development Management Development
Community Based Communication > Rural Development(or) Organization (or)Human
Health and Education | > Globalization and » Pragmatic Models of Rights
Management Development (or) Development > Development Ethics(or)

» Corporate Social » Introduction to » Research Project » Indian Economy
Responsibility (or) Demography » Development Practicum |>» Development Impact

» Sociology of » Working Paper » Soft Skills-Ill Assessment
Development » Soft Skills—ll » 0ut Bound Training- » Soft Skills-IV

» Development » Summer Internship Participatory Learning
Organization Observation and Development
Visits

> Soft Skills-|

Scope of the Programme

This programme is value-added, market-driven and employment-oriented course in the field of development. It is struc-
tured and designed to address the specific development requirements , CSR, NGOs, UN agencies, Government develop-
ment projects and other Autonomous bodies. As the outcome of such robust programme, the passing out candidates get
good opportunities for placement from regional to international organizations and foundations.

Value Added Courses : 1. Circular Economy & Sustainable Development 2. Fund Raising

Entrance Test will be conducted on campus when the applicants come for Admission. Date will be announced
by the Department.

*The syllabus for Entrance Test will be as follows:

1. Development Agencies: UN, UNDP, UNICEF, UNHCR, World Bank, IMF, UNCHR, FAD, ILO, UN Water and other
UN Organizations. Reports published by UN Organizations.

2. Development Issues: Poverty, Sustainable Development Goals, Human Rights, Disaster Management,
Water, Social Issues such as Caste, Class and Gender.

3. Research: Nature and scope of research, types of research, stages in social science research

4. Social Movements in India: Social Reform Movements and Environment Movements

5. Indian Constitution and Governance: Fundamental Rights and Duties, Parliament and State Legislature and

Local Governance.
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M.A. Social<Entrepreneurship

Sacial Entrepreneurship is a globally renowned field to solve social and environmental problems through innovative
business solutions. This programme synthesises courses related to society, management and entrepreneurship for
equipping the students as catalysts of change and to lead sustainable development.

Programme Pattern

SEMESTER | SEMESTER |l SEMESTER IlI SEMESTER IV
» Introduction to Social » Development Economics | > Project Management » Social Innovation and
Entrepreneurship > Social Marketing » Fund raising and Social Entrepreneurship
» Indian Society, Polity > Rural Entrepreneurship Resource Mobilization » Social Audit and Social
and Problems » Vulnerability and » Business Accounting Return on Investment
» Management of Social , , > Legal Framework of » Social Entrepreneurship
Enterprise Sustainable Environment Social Enterprise Leadership and
> Introduction to Research| > Women and Social > Social Venture Planning strategies
Methodology Entrepreneurship and Development > Technology Driven Social
> Public Policy and > Field Immersion Il (De | > Field Immersion Il Entrepreneurship
Governance signing Experiment for (Consolidation& Venture | > Research Project
> Field Immersmn I solving social problem) planning Course » Field Immer.smr.] IV(Start
(Ideation) > Soft Skills and Boot Outcomes (C0s)) up (Immersion into
» Soft Skills and Boot » Soft Skills and Boot Incubation)
Camp | Camp-ll Camp-ll > Soft Skills and Boot
» Summer Internship > Out Bound Training Camp-IV

Scope of the Programme

The programme prepares the students to become social entrepreneurial in all their future venturing, be it owning a social
enterprise else would it be to take up a profession in an organization, both ways our pass outs excel. We have our alumni
placed in highly reputed, Foundations, CSR Departments, Social Enterprises, Social Research Organizations besides
being Entrepreneurs of Social Ventures.

Value Added Courses

1. Design Thinking for the Social Entrepreneur 2. Systems thinking for social change
3. Green economy

Social Entrepreneurship Incubation Centre (SEIC)

The Social Entrepreneurship Incubation Centre is one of the Centres for Excellence in Madras School of Social Work. The
Centre will help students incubate social ventures during the first year of the programme and they graduate and provide
linkages with funding opportunities. It also runs independent projects and there is good possibility for the students to
get employed in those projects as well.

Entrance Test will be held on campus during Admission.

Date and pattern of the test will be announced by the Department.
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Research’Programmes

Master of Philosophy in Social Work

One of the flagship programmes of Madras School of Social Work (MSSW) is the Master of Philosophy (M.Phil.) in
Social Work Programme. The University of Madras has recognized MSSW for running the M.Phil. in Social Work
(Full-time), The curriculum has been thoroughly restructured and updated to meet the existing demands. A candi-
date who has passed the post-graduate degree in social work examination from the University of Madras or from
any other recognized University is eligible for applying for the full-time M.Phil. programme in Social Work. The
duration of the programme is one year spread across two semesters.

(For further details, kindly refer the Guidelines of the University of Madras)

Master of Philosophy in Psychology

An intensive one-year M.Phil. Psychology at the Department of Psychology, is designed to provide the candidates a
sound knowledge in the field of Psychology after their post-graduation. The course is designed for two semesters.
The curriculum provides hands on experience in the field of research, test construction, and counselling. They are
encouraged to construct and standardize a psychological test as the part of their dissertation in 2nd semester.
The program will prepare scholars launching themselves as consultant psychologist, trainers. They can also pursue
Doctoral programme. Candidates having passed 2-year P.G. Degree Programme in Psychology under 10+2+3 or 11
+ 1 +2 pattern are eligible.

(For further details, kindly refer the Guidelines of the University of Madras)

Doctor of Philosophy in Social Work

Candidates for admission to Ph.D. programme shall have a P.G. Degree from a UGC recognized university in India or
a professional degree declared equivalent to the PG degree by corresponding statutory regulatory bodies or profes-
sional councils like AICTE. Candidates should have obtained at 55% marks in aggregate or its equivalent grade Bin
UGC point scale (or an equivalent grade in a point scale wherever grading system is followed) in the PG degree. A
relaxation of 5% of marks from 55% to 50%, or an equivalent relaxation grade, may be allowed for those belonging
to SC/ ST | Differently-ab led or for those who have obtained the Master's degree prior to 19th September, 1991.
For a Ph.D. admission the candidate has to undergo an entrance test and other related procedures. The admission
happens as per the vacancy exists with faculty members.

(For further details, kindly refer the Ph.D. Guidelines of the University of Madras)

1

Nt
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DIPLOMA
PROGRAMMES

(Awarded by MSSW)




Postgraduate (Honours) Diploma in
Personnel Management and Industrial Relations

The P.G. (Hons.) Diploma in Personnel Management and Industrial Relations was started in the year 1978, is a two-year
highly intensive two-year programme designed for working professionals. e curriculum has been framed to cater to the
needs of every organization. The highlight of the programme is that, the faculty members are roped in from industries to
handle classes and equip the students to become HR Business Partner, HR Generalist, IR Specialist. The programme has
been well recognized in the industrial spectrum as well as among government organizations. The candidates who gradu-
ate from this programme are eligible to become Welfare Officers and the programme is a prescribed qualification for
direct recruitment as Assistant Commissioner of Labour (G.0.MS. No. 153. Dated 07/09/2017).

Programme Pattern

SEMESTER | SEMESTER |l SEMESTER Il SEMESTER IV
» Human Resource » Organizational Behavior |>» Accounts for Planning, |> International Human
Management > Rewards and Control, Business and Resource Management
> Lawsrelated to working | Performance Finance (lHR_M)
conditions Management » Laws related to Wages > Busmesg .
. , Communication
» Principles of » Laws related to » Marketing Management > Laws related to Social
Management Industrial Relations » Managerial Economics Security (Elective)
» 0C&O0D » Employee Relations » HR Analytics > Manufacturing
» Learning and > Research Methodology Management (or)
Development Entrepreneurship
Development
» Safety, Hygiene and
Health
> Research Project /
Industrial Visit

Admission Criteria and Eligibility
Any graduate who has passed out from any recognized University is eligible to apply for this programme. Preference in
admission will be given for working professionals. Fresh graduates may be admitted subject to availability of seats.

Programme Details
» Programme Duration : Two year - Evening Programme

> Class Mode : Online
> Timings :6.45 PM - 8.45 PM
> Examination - End Semester (Offline)

Diploma/Certificate: Students who complete first two semesters successfully, will be awarded with certification in
PMIR and those who complete three semesters will be awarded Diploma in PMIR, and those who complete all IV Semes-
ters will be awarded PG (Honors) DPMIR.

Towards end of every semester, students are required to attend physical class mandatorily for five/six days at the
campus and end semester examination will be conducted during this time.

Contact: Mr. M. Hemakumar

Assistant Professor & Coordinator

Mobile: +91 7502045805

Email: hemakumar@mssw.in / pmir@mssw.in
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Post Graduate\Diploma in
Human Resource Management

Madras School of Social Work in partnership with Kelsa Management Solutions Pvt. Ltd. off- ers the Postgraduate Diplo-
ma in Human Resource Management (PGDHRM). Th- e program covers the entire gamut of HRM to prepare line managers
and HR Professionals to design, implement and improve people systems and processes. -,e program provides, apart from
academic inputs, practical knowledge, experience and diverse perspectives from industry experts.

The modules covered during the programmeare as follows:
Human Behaviour In Organizations
Strategic Human Resource management
Managerial Communication
Organizational Structure and Design
Legislative Framework

Workforce Planning

Performance Management Systems
Employee Engagement

9. Learning and Development

10.HR Analytics

11.Industrial Relations

12.Total Rewards

O N~ WD

Faculty
Faculty for the programme will be industry experts who have theoretical and practical knowledge specialized to each
module.

Programme Highlights

e Emphasis on practical learning with a continuous comprehensive evaluation

e Programme content in line with current industrial HR practices and market trend
e Each module will be conducted by industry experts

e (uest lecture session by subject-matter experts for each module

e Access to MSSW Alumni Association on successful completion of programme

Programme Details

e The entire programme will be structured as distinct learning modules

e Astudent has to complete 12 modules to be eligible for the award of the PGDHRM
e Each module will have 32 session hours and will be completed over a month

Contact: Mr .K. B. Inian,

Assistant Professor & Coordinator
Mobile: +91 9445945900

Email: pgdhrm@mssw.in
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Post Graduate Diploma in Integrated Counselling

A one-year program offered by Nibbana Institute - Chennai and accredited by Madras School of Social work. Nibbana
Institute is a leading service provider in the field of psychotherapy and counselling. Their flagship educational program is
the Nibbana's Integrated Course on Counselling Skills - NICCS. Now they offer this program as a One-year Post Graduate
Diploma in Integrated Counselling.

Program Duration One year with 500+ hours of practical training.

Type Full time

Hybrid Model Classroom teaching+ Online modules+ Practical exposure

Program Start Date July 24th, 2024

Timings Monday to Thursday 9:30 am to 2:00pm

Application Deadline June 30th, 2024

Eligibility Indian graduates of all disciplines

Program Fee Rs. 3,25,000/- (+ GST)

Criteria for Completion Final written exam, a viva voce, 90% attendance & evaluations through the year

Contact: Coordinator
Nibbana Institute Private Limited
Mobile: +91 93452 23107 | Email: nipl@nibbanaindia.com | Website: www.nibbanatherapy.com

Module 1 - Personal Identity

Focus Process Outcome
Preparing the partici- | Our unique frameworks | - Developing identity of a
pant to own the identity | to be used as a lens for counsellor
of a counsellor self-discavery - Aligning the personality to
the role of a counsellor
Building self - - Ability to notice personal
awareness and styles influencing
shaping-up  for [ peveloping flexibility in | Group process and Counselling process
the role as a|the personality to | Self-reflections to - Ability to increase
counsellor accommodate a variety | enhance flexibility in
of client presentations | Self-knowledge communication patterns
Assignments reflecting | - Awareness about vulnerabili
self-growth ties, being authentic & having

ethical perspectives
Modelling personal well-being
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Post Graduate Diploma in Integrated Counselling

Module 2 - Integrating Theory 6: Practice

Focus

Process

Outcome

Significance on learning
various schools of

Integrating ,
counselling

Theory &
Practice

Using frameworks &
models to understand
client presentation and
formulating change
constructions

- Teaching and demon

stration of con
text-oriented practice

- Guidance from

practicing experts in
the field of mental
health

- Using AV recording for

self-monitoring and
feedback

- Assignments integrat

ing theory S: practice
with verbatims from
practice sessions

- Relevant counselling theories and
hands-on skill development

- Developing contact fullness with the
client

- Ability to notice incongruencies,
facilitate perceptual updates

- Tools and techniques in facilitate
changes

- Observational skills to pick up cues

- Ability to elicit unconscious patterns

- Corelating content and process

- Noticing blind spots and deaf spots

- Ability to begin and close sessions &
negotiate for further sessions

- Ability to set boundaries

- Body awareness of the counsellor

Module 3 - Client Application

Focus

Process

Outcome

- Hands-on experience
to start & close a
session

- Revisiting theory and

Application practice towards
& client work
Supervision | orientation

- Facilitating an
individual session &
making an overall
session & change
plan

- Understanding
professional ethics

- Realtime application

through 50 hours of
internship &
supervision

- Mini case studies
- Writing client

histories & verbatims

- Mini research &

presentations

- Ability to open a client’s narrative

- Ability to notice patterns in Client
behaviour, emational handling,
fantasies S: cognitive patterns

- Ability to notice patterns of clients in
engaging in relationships

- Framing hypothesis (diagnosis)

- Ability to make contracts

- Construct change options for client

- Ability to use models and frameworks
in diagnosis S: treatment

- Maintain internal balance while
working with the client

- Awareness of emotions,
compulsions, judgements and
agendas of self

Program Outcomes

On successful completion of the program, you will be ready to start your own practice and interact with clients. You will
have a thorough understanding of the subject and the confidence of client interactions. The program also significantly
enhances your personal life, by making you look inwards and grow as an individual. You have a deeper understanding of
yourself and how to improve your personal and professional interactions, to bring peace and happiness in your life.
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Diploma in Integrated Mental Health Care

India with a growing gap in mental health professional workforce, calls for an urgent need of grassroot level workforce
who can bridge the care gap of 70-85%. They are in need of academic level training which targets building knowledge,
attitude, skills, exposure and experiential learning and approach service users from 'bio-psycho-social perspective”. A
worker who is informed, and underwent experiential learning becomes a value addition to the multi-disciplinary approach-
es in mental health care. This course is designed to equip persons to be a primary point of contact for mental health care
at the grassroots level (institution or community). The multi-dimensional, pluralistic societies such as ours need more
"generalists” other than specialists, who could work with vulnerable groups.

Programme details
This 6-months course is offered in Tamil Medium and follows in-person teaching of 150+ hours (6 hours per week) and
150 hours of field work as part of the participants’ work/living environment. The following are modules.

Understanding of self, community and service users

Health & Wellbeing, Mental health, and Mental lliness

Mental health promotion, Prevention of mental disorders and Mental health care
Sacial determinants of mental health and social care

Mental healthcare approaches - individual, group and community

o A W\ =

The course is offered in collaboration with Banyan Academy of Leadership in Mental Health. Supported by Sundram
Fasteners Ltd.

Admission criteria
Anyone with 10th standard qualification and proficiency in Tamil interested in mental wellbeing of people can apply.

Faculty
The expert faculty includes Psychiatrists, Psychologists, Mental Health Social workers, Nurses, Social welfare experts,
and senior grass-roots mental health care workers.

Contact

admissions@balm.in
Ph:+91 8754495498
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Diploma in Mental Wellsbeingref Vulnerable Children

UNICEF reported that half of the world's mental health conditions start by the age of 14 and most of them are undetect-
ed and untreated which may worsen as the child becomes an adult. The National Mental Health Survey (2015-2016)
found that children aged 13-17 had reported mental health disorders with 7.3% from urban areas and 6.9% from rural
areas. Further, factors such as family dysfunction, poor socio-economic status, and experiences of violence, parental
mental illness and neglect can make some children more vulnerable to developing mental health issues. The course aims
to provide knowledge to professionals, teachers, persons interested in children and caregivers to understand and identify
vulnerable groups of children and develop skills to work with them to promote mental well-being. The multi-dimensional,
pluralistic society such as ours need more "generalists" other than specialists, who could work with the vulnerable
groups of children.

Program Details

This 6-months course, is offered in Tamil, follows an in-person teaching structure, combining 150+ hours of theory (6
hours every week) and 150 hours of fieldwork, embedded in the participants’ work environment. The following are the
modules

1. Understanding personal and professional self

2. Understanding Mental Health and Development of Children

3. Understanding and Recognizing Vulnerability of Children

4. Skills and Techniques for Working with Vulnerable Children

5. Policy, Legal and Programme Framework for Care and Protection of Children

The course is offered in collaboration with Banyan Academy of Leadership in Mental Health and Rainbow Homes Program,
supported by Sundram Fasteners Limited.

Admission criteria
Anyone with 10th standard qualification and proficiency in Tamil, and interested in mental well-being of children can

apply.

Faculty
The sessions are facilitated by subject experts from The Banyan, Banyan Academy of Leadership in Mental Health,
Madras School of Social Work, the Rainbow Homes program and other expert organisations.

Contact

admissions@balm.in
Ph:+91 8754495498
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Diploma in Transdisciplinary Research and Practice

Contemporary societal issues, such as those related to health care or sustainable development, are often very complex.
They can be rooted in deep organizational, political and social issues that involve many different actors, all with their own
perspectives. For this reason, contemporary societal problems are often called 'wicked' or 'persistent’ problems.
Increasingly, the fields of (global) health and sustainable development research are recognizing the importance of defin-
ing these problems through the eyes of all actors involved.

This implies that multiple approaches, fields of science and frames of reference are integrated to build specific, practi-
cal, experiential and scientific knowledge about the problem with those directly confronted with it. A transdisciplinary
approach that aims for integrated knowledge generation is essential to do justice to the multi-faceted nature of persis-
tent problems. Moreover, it is rapidly becoming a key paradigm in responding to persistent problems. The programme
offers participants with transdisciplinary research and practice skills which may be employed in variety of settings
including health, community development, environment management etc.

Program Details

This 7-month course is offered in English Medium and follows hybrid (in-person & on-line) mode of teaching
(50+ hours). The following are the focus areas of the programme.

1. Complex & persistent problems

2. Theoretical foundations of transdisciplinary research

3. Designing & evaluating TOR

4. Dealing with Diversity

5. Using transformative methods

B. Role of the researcher, power and reflexivity

This course is offered in collaboration with Banyan Academy of Leadership in Mental Health and Vrije University,
Amsterdam, supported by Sundram Fasteners Limited.

Admission criteria
Anyone with under graduation interested in transdisciplinary perspectives in research can apply.

Faculty
Subject experts from Vrije University, Banyan Academy of Leadership in Mental Health, and Madras School of Social work.

Contact

admissions@balm.in
Ph:+91 8754495498
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Field Work and<nternship Organizations

All the programmes offered by Madras School of Social Work are field-based, the students pursuing the course of their
choice will get opportunities to undergo concurrent (weekly two days) and block (30 days in a semester of 90 days)
pattern. The focussed field training happen in various specialized organizations with whom the institute has developed
an excellent network over time. Following are a indicative list of organizations from a long list of organizations in which
the students will get an opportunity to get placed for their field learning and practical training.

An Indicative List of Our Field Work and Internship Organizations

AARVAM NGO

ABHASA

ACCESS PEOPLE

ACCORD METROPOLITAN HOTEL
ACTION AID

AGARWAL EYE HOSPITAL (CORP)

AHAL HOSPITAL

AIDE ET ACTION

AIESEC

AIR INDIA

AIRTEL

ALL WOMEN'S LIFE SAVING CENTRE
ALLISON TRANSMISSION INDIA PVT. LTD.
ALLSEC TECHNOLOGIES LIMITED
ALPHA TO OMEGA SPECIAL EDUCATION
AMBASSADOR PALLAVA

AMBATTUR FASHION INDIA PRIVATE LIMITED
ANNAI' HOSPITAL

APOLLO CANCER HOSPITAL

APOLLO CORPORATE ENTERPRISE LTD
APOLLO HOSPITAL

APOLLO TYRES

APT RESEARCH CENTRE

APTIV COMPONENTS INDIA PVT LTD

ARAKAWA STANLY WADOKAI INDIA ARUNO-
ARM

ARPANA FOUNDATION

ARUWE

ARVIND FOUNDATION

ASCO NUMATICS PVT. LTD.

ASHOK LEYLAND

ASIAN PAINTS PVT. LT.D

ASSOCIATION FOR RURAL WOMEN EMPOW-
ASTEP - DR. SIVAKAMI ARUMUGAM

BALA MANDIR

BALA VIHAR SCHOOL

BELIEF SYSTEMS

BELSTAR MICROFINANCE PRIVATE LIMITED
BENZZ PARK

BGR ENERGY SYSTEMS, CHENNAI

BHARAT HEAVY ELECTRICALS LIMITED
BHARATHIYA YUVA SHAKTI TRUST — BYST
BHEL PSSP

BHEL-RANIPET

BHUMI

BILLROTH HOSPITALS

BLINK

BOSCH

PROSPECTUS
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Field Work and<nternship Organizations

An Indicative List of Our Field Work and Internship Organizations

BRAKES INDIA PVT LTD

BRAVOH MOVEMENT

BRITANNIA INDUSTRIES LTD

BUILD HR CONSULTANTS

HEALTHIUM MEDTECH PVT. LTD.
HEXAWARE TECHNOLOGY

HINDUJA TECHNOLOGY

HINDUSTAN COCA-COLA BEVERAGES PVT.
HOWDEN SOLVENT INDIA PVT LTD

HTC GLOBAL SERVICES

ICF

INDIA PISTON LTD

INDIA YAMAHA MOTORS PVT LTD

INDIAN COMMUNITY WELFARE ORGANIZA-
INDIAN COUNCIL FOR CHILD WELFARE
INDIAN OIL CORPORATION LTD

INDIGO AIRLINES

INDIGO-AGILE AIRPORT SERVICES

INDUS CRAFT

INSCRIBE GRAPHICS

INSPIRISYS SOLUTIONS LIMITED
INTEGRATED RURAL COMMUNITY DEVELOP-
INTELLECT

INTERNATIONAL ALLIANCE FOR THE PRE-
INTERNATIONAL JUSTICE MISSION
INTHREE ACCESS SERVICES PVT. LTD.

IP RINGS

JUBILANT FOODWORKS LTD.

JUSTDIAL

JUSTICE AND HOPE

K.C. SANKARALINGA NADAR HR. SEC. SCHOOL
KALIKA MINDSPACE

KANSAI NEROLAC PAINTS LTD. HOSUR
KARYOUN INNOVATION PVT LTD

KAUVERY HOSPITALS

KAVITHALAYAA COUNSELING CENTRE

KCP LTD

KELLOGG'S (KELLOGG COMPANY)

KEMIN INDUSTRIES SOUTH ASIA PRIVATE LTD.
KONE ELEVATORS INDIA PVT. LTD.
KORCOMPTENZ

KOVAI MEDICAL CENTRE AND HOSPITAL
KUMARAN HOSPITALS

KUN AEROSPACE

L&T BUILDINGS AND FACTORIES

L&T CONSTRUCTIONS

L&T CSR

L&T SMART WORLD AND COMMUNICATION
LAR INC

LAUNCH PAD

LIASON INC

LIFE CELL INTERNATIONAL PVT LTD

LIFELINE HOSPITAL

LITTLE DROPS

LOTUS WELLNESS AND REHABILITATION CENTER

LOUISE MOUNT HOSPITAL

*
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Field Work and<nternship Organizations

An Indicative List of Our Field Work and Internship Organizations

LUCAS TVS LTD

MADRAS AGRO EXCHANGE TRADING
MADRAS CHRISTIAN COUNCIL OF SOCIAL
MADRAS DYSLEXIA ASSOCIATION

MADRAS MEMORY CLINIC

MAGIC BUS

MAGIZHCHI, POLICE WELLBEING PROGRAM
MANAS - DR. CHITRA ARAVIND

MANASU

MANZA RETAIL PVT LTD

MARIALAYA

MARY ANNE CHARITY TRUST
MATRIMONY.COM

MAX FASHIONS

MENT SOCIETY (IRCDS)

MENTS

MERIT SOFTWARE SERVICES PVT. LTD.
MGM HEALTH CARE

MIND CAFE - DR SUMATHI CHANDRASHEKARAN
MIND ZONE, CHENNAI

MISSION TO THE BLIND

MMM HOSPITAL

MODERN FOODS ENTERPRISES
MONTFORD COMMUNITY DEVELOPMENT
MPHASIS

MRF LTD.

MS SWAMINATHAN RESEARCH FOUNDATION

MUKTA FOUNDATION - DR. ASHWINI

NAKURAS

NALANDAWAY

NASSCOM

NAWA: NILGIRIS ADIVASI WELFARE ASSOCIA-
NECURITY SOLUTIONS
NEWGEN KNOWLEDGE WORKS
NEWS 7

NICOLA FOUNDATION
NIMHANS, BANGALORE

NLC INDIA LIMITED

NOTION PRESS LTD

NOVOTEL

NSK BEARINGS INDIA

NTRUST INFOTECH PVT. LTD.
NVANDI

OASIS

OFFER

OLAM INFORMATION SERVICES
ONE LIFE HOME HEALTHCARE
ONGC

ORGANIZATION

PAADHA

PAYIR TRUST

PENINSULAR RESEARCH OPERATION
PERIFERRY

PFIZER

PICKYOURTRAIL

PINNACLE BLOOMS NETWORK
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Field Work and<nternship Organizations

An Indicative List of Our Field Work and Internship Organizations

PNB MET LIFE INSURANCE

POLARIS

PON PURE CHEMICALS LTD.
PRACTICES

PRAXIS INSTITUTE FOR PARTCIPATORY
PRENETICS INNOVATION LAB PVT. LTD.
PRISM TRUST

PRO - PENINSULAR RESEARCH OPEARTIONS
PROPHEONIX TECHNOLOGIES
PSYCAFE

PSYHUB

PUTHRI

PVR AEROHBUB

PVR CINEMAS

QUIPSERVE PVT. LTD.

RADIANT INFO TECH

RADISSON BLU HOTEL

RAGE COMMUNICATIONS

RAINBOW HOMES (ARUN)

RAJU HOSPITAL

RAMACHANDRA HOSPITAL

RAMADA

RAMCO CEMENTS

RANDSTAD

RANE (MADRAS) PVT. LTD.

RANE BRAKE LINING LIMITED

RANE INSTITUTE OF EMPLOYEE DEVELOP-

RANE NSK

RATHNA CENTER FOR CONSCIOUS LIVING - DR. SAMPOORNA
REDINGTON

ROCA PARRYWARE

SALEM STEEL PLANT

SELLING SERVICES

SHRI AMM MURUGAPPA CHETTIAR RESEARCH CENTRE
SIMS HOSPITAL

SODEXQO INDIA SERVICES PVT. LTD

SOMERSET GREENWAYS CHENNAI

SRM HOSPITALS

TAMILNADU DOMESTIC WORKERS WELFARE TRUST
TEAMLEASE SERVICES LTD

TECH MAHINDRA FOUNDATION

THAAGAM FOUNDATION

THE CANDLES

THE MIND AND COMPANY

THE MIND CARE

TITAN CORPORATE COMPANY LIMITED

TOSHIBA JSW POWER SYSTEMS

TRANSCEND - DR SRIVIDHYA

UNITED WAY OF CHENNAI

VA TECH WABAG

VENTION OF AIDS

YANA - COUNSELLING CENTER

ZF COMMERCIAL VEHICLE CONTROL SYSTEM
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Infrastructure and<Student-Support Services

A. Library

Our MSSW Library is a gateway to a world of knowledge and resources tailored to meet your academic needs.
Qur library is committed to providing comprehensive information services to faculty members, research
scholars, and students of the MSSW community.

1. Fully Computerized: MSSW Library is fully computerized, ensuring efficient access to resources and
Services.

2. 24/7 Access: Enjoy round-the-clock access to the International Online Public Access Catalogue (IOPAC)
via both web and mabile app platforms.

3. Extensive Collection: Explore our impressive collection of books, Proquest e-books, journals, e-journals,
and EBSCO database subscriptions.

4. E-Resources: Access INBLIBNET's e-resources using individual passwords provided to faculty members,
research scholars, and students.

5. Article Indexing: Our library has indexed approximately 45,000 articles from various scholarly journals to
facilitate research endeavaors.

8. Digital Library: Immerse yourself in our Digital Library, offering access to research theses, in-house
publications, and other digital content published by MSSW.

Programs and Initiatives:

e Know Your Library Sessions: Tailored sessions are conducted for new students at the beginning of each
academic year to familiarize them with library resources and services.

e Library Week Celebration: Join us for a week-long celebration filled with exciting competitions and
activities. W inners receive prizes and certificates as tokens of appreciation.

¢ Information Literacy Programmes: Engage in programs designed to enhance research skills and
information literacy, supporting your academic pursuits.

e Reflections Readers Forum: Participate in presentations and discussions on diverse books, articles, and
current topics to broaden your intellectual horizons.

e Friday Quiz: Challenge yourself with our weekly Friday quiz, aimed at keeping you updated on current
events. The quiz is conveniently circulated via social media platforms like Instagram and Linktree for easy
access.

At MSSW Library, we are dedicated to fostering a culture of learning and intellectual exploration. Join us on

this journey towards academic excellence and discovery. Explore, learn, and grow with MSSW Library.

B.GYM

Discover the vibrant heart of our college community at our newly established gym, inaugurated in 2023 with
a vision to promote holistic student well-being. Our gym boasts a comprehensive array of cutting-edge equip-
ment catering to diverse fitness preferences, from cardio enthusiasts to weightlifting aficionados. Engi-
neered with student safety in mind, our flooring ensures a secure environment for rigorous workouts and
personal growth. Dedicated volunteers stand ready to provide guidance and support, empowering every
student to navigate their fitness journey with confidence. Step into our gym and embark on an exhilarating
path to enhancedhealth and vitality, where every workout becomes a transformative experience.

C. SKILL DEVELOPMENT

Apart from regular academic classes, skill development sessions are conducted using external and internal-
training experts in accordance with the departments' specific requirements. Self-development, interpersonal
effectiveness, life skills as well as specific professional skills are imparted through special training

programmes. +
PROSPECTUS ¢ 2024 - 2025
+




Infrastructure and<Student-Support Services

D. STUDENT CLUBS & FORUMS

Various student clubs like the NSS, Red Ribbon Club, Eco Club, Consumer Club, Rotract Club, Debating and
theatre Clubs and the Anti-Narcotic Club in the college accelerate positive growth and also create awareness
of social issues. The college has guidance and counselling support services for students and the public. All
students are members of the Students’ Development Council. The Council arranges for a variety of
programmes like lectures, debates, sports, games, cultural competitions and social service projects. In addi-
tion, each department has a department forum to organize co-curricular activities for the professional devel-
opment of the students on self-supporting basis.

E. SCHOLARSHIPS

The following Scholarships are available to deserving students of MSSW.

Government:
1. State Government BC/ MBC / SC/ ST Scholarships
2. Central Government - Single Girl Child S: other scholarships.

College

3. SSER Management Scholarships for economically deserving students of any programme at MSSW worth
up to 50% of the programme fees.

4. MSSW Alumni Association Scholarships for economically deserving students of any programme at MSSW
covering about 20% of the fees.

Institutions/NGO

5. ABAN Cares scholarships worth Rs. 25,000/- each for five 1st Year students in any post graduate
programme at MSSW.

6. "AA Ithapiri Scholarship" from the Isaac Foundation for second year PG girl students based on Merit
cum Means.

7. The Rajeswari Nathan Foundation Scholarship for PG girl students based on their socioeconomic
background

8. Swaminathan Padmavathi Trust Student Scholarship: Rs. 10,000 per student for 2 PG students from SC
Community pursuing 2nd Year MSW / MADM / MASE programme

9. Cognizant Foundation Scholarships for economically deserving students of MSW S:MA Development
studies for Rs.60,000 per year for both years of study.

10. Thejo Engineering Schalarships for economically deserving and meritorious Bachelors degree student

11. BALM - Sundram Fasteners Limited scholarships for economically deserving students of MSW (SF)
Mental Health specialization covering college and hostel fees for all two years of the programme.

F. HOSTEL

The Management runs a limited hostel and mess facility inside the campus for the benefit of the outstation

students. Preference will be given to students from States other than Tamil Nadu. Accommodation is provid-
ed for both Postgraduate and Undergraduate students. After getting admission in the college, students have
to approach the hostel warden separately for hostel accommodation. Allotment of rooms will be made by the
hostel authority on first-come, first-serve basis. Gaining admission to a programme does not guarantee a
place in the Hostel. Applicants are encouraged to explore other hostels and paying guest accommodation

available in the city.
+
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Important-Student:Regulations

Ragging

Exemplary conduct is imperative for all students. Conditions stated in the prospectus and College Calendar
will be binding on students and parents/guardians at all times. Ragging is strictly prohibited on the campus.
Those who indulge in ragging will be summarily expelled from the college and may also be subjected to prose-
cution as per law.

Zero Tolerance Policy towards Sexual Harassment

Madras School of Social work (MSSW) will not tolerate any form of sexual harassment. The campus is free
from discrimination, harassment, retaliation or sexual assault at all levels. Any form of sexual harassment
can be given in writing to the Internal Complaints Committee (ICC) of MSSW. The ICC will conduct the enquiry
and submit its report to the authorities of MSSW.

If the offender is an employee and if found guilty of sexual harassment they shall be punished in accordance
with the service rules of MSSW.

If the offender is a student, depending upon the severity of the offence, MSSW may,

i)  withhold privileges of the student such as access to the library, auditoria, halls of residence,
transportation, scholarships, allowances, and identity card;

ii) suspend or restrict entry into the campus for a specific period;

iii) expel and strike off name from the rolls of the institution, including denial of read mission, if the
offence so warrants;

iv) award reformative punishments like mandatory counselling and, or, performance of community
services.

All sexual harassement complaints can be brought the notice of Internal Complaints Committee Members.
The details of ICC members are given in the college website and can be reached at icc@mssw.in

Attendance and Regularity

Minimum 75% attendance is compulsory for class room instruction and 100% for practical / field work and
other important events in the college. Every student must attend college regularly, punctually and perform
satisfactorily throughout the programme.

Absence from class for one hour will be treated as absence for half a day. No student shall be absent on the
re-opening day and closing day of a semester. Attendance shortage will entail punitive action including fine
or denial of permission to write End-Semester Examinations.

Discipline
Smoking, Consuming Alcoholic Drinks and Narcotic Drugs are strictly prohibited. Any unruly conduct by a
student either in the class or on the premises will invite suspension and/ or dismissal. Mobile phone use is
restricted to college ground only. Phones used in class and inside buildings without due permission will be
confiscated.

The College reserves the right to dismiss a student at any time whose conduct is considered unsatisfactory

for any reason.
+
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Important-Student:Regulations

Programme Fees

Students who are selected for admission will have to pay the prescribed programme fee in full as mentioned
in the Fee Structure Sheet. Students of self-financed programmes will be given the facility to pay fees in two
installments (semester-wise). Fees for the first semester as indicated in the Fee Structure Sheet should be
paid at the time of admission and the subsequent semester fees should be paid within 30 days of commenc
ment of the semester. Fees not paid within the stipulated time will be accepted only with fine as prescribed
by the college management from time to time.

After the expiry of 30 days from the last date of fee payment, the defaulter's name will be removed from
theroll and he/she will be re-admitted only on payment of arrears and fine upto the date of payment and
re-admission fee of Rs.50/-. Likewise, the hostel fee also needs to be paid as per the time schedule
prescribed by the authority concerned. Failure to adhere to timelines will lead to denial of hostel accommoda-
tion.

Fees can be paid online or through bank challan downloaded from the website. Fees once paid will not be
refunded for any reason whatsoever.

Actual expenses towards trips for field work, observation visits, rural camps, out-bound training, preparation
of research report, will be met directly by the student's concerned, as and when required. Payment to
Agencies for field work training should also be borne by the students who are availing such training.

Vehicle Parking

Students are permitted to park only two wheelers inside the campus. Students are encouraged to use public
transport system to reach the college. Due to inadequate parking space, four wheelers of students are not
permitted inside the campus for any reason whatsoever.

Average CTC (lacs p/a)

6.8

4.6 46 9 49

2018 2019 2020 2021 2022 2023
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Campus Placement

MSSW has a placement cell which is headed by a Placement Coordinator. It provides equal opportunities for
all students to sit for placements and facilitates maximum number of placements, though the college does
not guarantee placements for all, due to various reasons. Many of the recruiting organizations have their own
eligibility criteria according to their company policies and candidates who fulfil those criteria alone are
preferred by the organizations. Most organizations require a minimum of 60-70% marks from 10th standard
to post graduation with no history of arrears to appear for campus interview. Further, students are expected
to relocate to any where in India or abroad depending on the organization's roles and requirements.

MSSW placement cell follows the policy of one offer for one candidate to ensure that maximum number of
students get benefitted. Once students sit for placement process in a particular company after a pre-place-
ment talk, they have to appear for the same and accept the offer, if any. Students who apply and then choose

not to appear will be debarred from the subsequent placement processes.

An indicative list of our recruiters in the last few years

AARDE FOUNDATION DDIRECT DIALOGUE INITIATIVES INDIA
ACCENTURE DR. REDDY'S FOUNDATION
ADANI PORT E&Y DDU-GKY PROJECT
AKTREA ALTIMETRIK FORD MOTORS

AMWAY FUTURISK

AMAZON GSK MEMORIAL SCHOOL
ANGARAI CONSULTANTS HABITAT FOR HUMANITY INDIA TRUST
ASHOK LEYLAND HEX

ASSESS PEOPLE SERVICES HTC

AVTAR HYUNDAI MOTORS

AZIM PREMJI FOUNDATION ICICI

BAHWAN CYBERTEK BANK IFMR

BAZAAR BIO XGREEN [IT MADRAS

BIRLA SUN LIFE INDIA TURNS

BORN GROUP BUILD PINK |

HR INTELLECT

BVM GLOBAL SCHOOL INTROLLIGENT SOLUTIONS
CAP - CHILD AID PROJECT INSPIRISYS

CHRYSALIS KARADI PATH

CIEL HR KELSA

COGNIZANT TECH SOLUTIONS KLA-TENCOR

CONNECTED TECHNOLOGIES KOTAK

CCARBORUNDUM UNIVERSAL L & T LEVERAGE
COROMANDEL CEMENTS LUCAS TVS
CREA-SHAKTHI INDIA LITTLE GYM

BS MADURA COATS

DALMIA CEMENTS MPHASIS

COCA COLA MV HOSPITALS

DELPHI TVS NESTLE
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Campus Placement

An indicative list of our recruiters in the last few years

NISSAN SVATANTRA MICRO HOUSING (ADITYA BIRLA GROUP)
RAMCO CEMENTS SYNTEL

RAMCO SYSTEMS TAFE

RANDSTAD AGNIKUL

RANE BAHWAN CYBERTEK

ROYAL ENFIELD BARCLAYS BANK

SAGA CONSULTING DAIMLER INDIA COMMERCIAL VEHICLES
SAINT-GOBAIN ELASTICRUN

SIEMENS GENINFY ROBOTIC LABS

SIFY HINDUSTAN UNILEVER LTD.

SOS CHILDREN'S VILLAGE L&T CORE HR

SPIECES MANUFACTURING MINDTREE

STERLING INSURANCE NESTLE INDIA

INVOLVE LEARNING SOLUTIONS RR DONNELLEY

[ONIXX TORRENT GAS

ITC FOOD DIVISION VEDANTA NATURAL RESOURCES
JOCATA RELIANCE FOUNDATION

JUST DIAL LETS ENDORSE DEVELOPMENT PVT. LTD.
KALEESUWARI AKSHAR ARBOL INTERNATIONAL SCHOOL
TAMILNADU PETRO CHEMICAL CORPORATION BOUNTEQOUS

TATA ELXSI CROMA TATA GROUP

TATA MOTORS CMRGT

TATTVA JAIPUR RUGS

TCS KAAR TECHNOLOGIES

TEACH FOR INDIA KELSA SOLUTIONS

TEAM LEASE PROJECT CACA

THE HINDU PROKLEAN

THE INDIAN PUBLIC SCHOOL SAPIENCE PUBLICATIONS

TITAN INDUSTRIES LTD ZUCI SYSTEMS

TVS CSR BANYAN

ULTRA TECH CEMENTS BUILD HR

VALUED EPISTEMICS EMPOWER FOUNDATION

VARTHANA HL MANDO AUTOMOTIVES

VEDANTA LIMITED OLA

VELAMMAL SCHOOL PENINSULAR RESEARCH OPERATION
VESTAS PRADAN

VIRTUSA REVATURE

WORLD BANK SUNDARAM FASTENERS

ZOOMRX THE EDUCATION ALLIANCE

SULEKHA SUNDARAM CLAYTON

+
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2024 - 2025-Admission Regulations

(Unless otherwise specified in the programme detail)

e At the time of applying, candidates studying in 3 year degree programme should have passed in all the
subjects from the 1st to bth Semesters and candidates studying in 4 year degree programme should have
passed in all the subjects for the 1st to 7th Semesters.

e Admission will be based on merit. For the P.G. programmes marks secured in Degree programme, Entrance
Test and Interview will be taken into account for merit list preparation. The weightage for each component
is as follows: Degree Marks: 50, Entrance Exam: 25 and Group Discussion / Interview: 25. Community
Quota allotments will be followed as per Tamil Nadu Government Rules. 0BC/SC/ST candidates from
States other than Tamil Nadu will be considered under General Category only.

e Applicants are asked to write statement of purpose (SOP) provided in the application.

e After Entrance Test, Applicants will be shortlisted for Interview based on combined UG percentage and
Entrance Test marks. For every seat available, five applicants will be shortlisted based on merit and
called for Interview.

e Forthe P.G. programmes, candidates can apply based on marks up to Il year in case of non-semester
pattern and V/VIl semester in case of semester pattern.

e Admission to all the programmes will be provisional until final mark sheet in case of HSC / Bachelor's
Degree Certificate and final mark lists are produced and is also subject to University's approval.
Candidates failing to produce marks certificate (for ALL semesters) or University approval within the
stipulated time will forfeit admission.

e Admission is subject to verification of marks certificates and if the mark certificates are found to be
false, admission is liable for cancellation besides criminal action being taken. Fees paid for admission will
not be refunded.

e After admission, sliding from one programme to another may be permitted depending upon availability of
seats. The is will be permitted only if the candidate has applied and appeared for interview for the
programmes.

e Students whose knowledge of English or Tamil (for MSW Programme) requires im-provement will be
notified soon after admission and it will be obligatory for them to arrange tuition in these subjects at
their own cost.

e MSSW is an equal-opportunity institution. Candidates from transgender communities and person with
disabilities are encouraged to apply.

e All admission related communication shall be notified ONLY in the college website (www.mssw.in) and
through the email-ids given by candidates in their appli-cation. In case of failure in delivery of
emails, the college authorities will not take responsibility for the same.

Important Information:

The College does not accept donations/capitation fee for admissions. Admissions are made purely based on
merit and the prescribed criteria for each programme. Candidates are advised against paying any money to
anyone within or outside the College to secure admission for any programme at MSSW. Candidates / Parents
/ Guardians are requested to bring to the notice of the Principal if they come across any information regarding
such violations. The information can be emailed to principal@mssw.in. Admissions will be cancelled for
those students who gain admission using any malpractices.

+
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Application Proeedure

Applicants can apply only ONLINE and pay the required application fees through the online payment gateway.
Detailed instructions regarding on line application procedure and payment is given the admission page of the
college website: mssw.in

For any enquiry regarding admissions call only between 10 A.M. to 4 P.M. on all working days.

Phone: +91 - 44 - 28195126 , +91 - 44 - 28194566, +91 - 44 - 28192824.

For detailed application procedure read the instruction for applicants given in the college website.

Model Question Paper is available for reference on the College website in the Admissions page.

Post Graduate Programmes Admission Schedule 2024

Particulars Important Dates
1. |Online Application opening Date 15t April 2024
MSW Aided | MAHRM | MAHROD 28™" May 2024
h
2. |0nline Application Closing Date MSW SF A& B | MSW D&E 15% June 2024
MSc CP | FC 15" June 2024
MASE | MADS 30" June 2024
MSW Aided | MSW SFA & B ot o ard
MSW D & E 1t to 379 June 2024
MAHRM | MAHROD 4™ to 6th June 2024
3. | Online Entrance Examination Date st - 17t — 19t May 2024
MSc CP | FC 1st Slot; 17t — 19™ May

2" Slot : To be announced later
MSWSFA&GB|MSWD &E |2 Slot : To be announced later

NO Online Entrance Test for MASE & MADS programs

MSW Aided | MSW SF A & B 5t June 2024 onwards
MSWD & E
Publication of Interview / MAHRM | MAHRQOD 8" June 2024 onwards
% |60 Schedule MSc CP | FC 21t May 2024 onwards
MASE | MADS 15% May 2024 onwards

Interview/ GD/ Original Certificate

verification at MSSW Campus, Chennai To be communicated to applicants by each program.

Publication of provisional lists of
SELECTED & WAITLISTED candidates

7. |Online payment of fees To be communicated to selected students by each program.
Principal/HOD/Faculty Meeting with

As and when the lists are ready.

th
& Admitted students and their Parents 177/uly 2024
g | Year Inaugural & Welcome by 187 July 2024
Departments
10. |Student Induction Program 19 - 20 July 2024
Note :

 The given dates are tentative and may be changed as per prevailing situation and Government regulations.
e Interview / GD S: Original Certificate verification will be only at MSSW campus in Chennai.

+
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Application Proeedure

Under Graduate Programmes Admission Schedule 2024

S. No. Particulars Important Dates

1. | Online Application opening Date | On the Date of publication of Tamil Nadu State Board 12 results
2. | Online Application Closing Date | 10 working Days after opening of Online Application Form

Publication of provisional lists of . . S

D fter cl f Online Application F

3| SELECTED & WAITLISTED candidates | © 2YS after closing of Online Application Form
4. | Online payment of fees To be communicated to selected students by each program.
5. | Principal/ HOD/ Faculty Meeting with | 17t July 2024

Admitted students and their

Parents
5 IDYearInauguraI & Welcome by 18" July 2024

epartments

7. | Student Induction Program 19th - 20th July 2024
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Fee Strueture - Batch 2024

In Paying in Installments

Post Graduate Courses Year Annual Fee I .
Master of Social Work (Aided) 24-25 43,500 — b
All Specializations 25 - 26 49,500 NA NA
Master of Social Work (SF 1l A) 24-25 1,00,000 NA NA
AR 25 - 26 1,00,000 70,000 30,000
Master of Social Work (SF Il A 24-25 73,000 NA NA
& B) All Specializations 25 - 26 73,000 52,000 21,000
Master of Social Work 24-25 73,000 NA NA
(Disability & Empowerment) 25 - 26 73000 52,000 21,000

24-25 1,30,000 NA NA
M.A. Human Resource Management
25-26 1,30,000 90,000 40,000
M.A. Human Resource & Org. 24-25 1,30,000 NA NA
Development 25 - 26 1,30,000 90,000 40,000
24-25 69,000 48,000 21,000
M.A. Development Studies
25-26 69,000 48,000 21,000
. 24-25 86,000 NA NA
M.Sc. Counselling Psychology
25-26 86,000 60,000 26,000
. . 24 -25 86,000 NA NA
M.Sc. Counselling Family Therapy
25-26 86,000 60,000 26,000
24 -25 69,000 48,000 21,000
M.A. Social Entrepreneurship
25-26 69,000 48,000 21,000
Under Graduate Courses Year Annual Fee
24 -25 56,000
Bachelor of Social Work 25-26 56,000
26 -27 56,000
24 -25 66,000
B.Sc. Psychology 25-26 66,000
26 - 27 66,000
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Fee Strueture - Batch 2024

Note:

1

2.

3.

The full First year fee must be paid at the time of Admission. No extension of date or time will be given to pay the fee.
Admission will be confirmed only after fee payment.

The subsequent Annual fees and/or instalments must be paid within one month after semester re-opening. As per
Govt. norms, names of students who do not pay fees within the stipulated time will be removed from rolls.

The fee indicated for subsequent academic years is only tentative and subject to revision.

The fee includes tuition fee, examination fee, soft skills, mandatory certificate courses, University charges
(Admission fees, Convocation fees, Permanent pass register fees), library, campus development and all curricular
activities.

Students will bear all other charges related to field work travel, 0BT, Rural Camp, co-curricular and extra-curricular
activities.

6. Alumni membership fee of Rs.500 is included in the First year Fees.
Hostel Fee
Hostel Fee Amount Fees (Annual) | Installment Il Instaliment
Rent 55,000
Mess 48,000 1,08,000 65,000 43,000
Caution Deposit 5,000
Note:

1. The Annual Fee / First Installment must be paid at the time of Hostel Admission. No extension of date
or time will be given to pay the fee.

2. The Second Installment must be paid on or before 15th December 2024

3. Students who do not pay fees within the stipulated time will be asked to vacate hostel

4. The fee is subject to revision every year.

5. On vacating the Hostel, the caution deposit will be refunded after deduction of dues if any.
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Programme Contact Details

The following contact numbers / email ID's can be contacted for specific queries about the Programme. For
any other information refer to the Prospectus or the General Enquiry Lines.

Call Timings: 10 am — 4 pm (Monday to Friday). Calls apart from the specified time and day will not be enter-
tained.

Programmes Mobile Number Email ID
Master of Social Work (Aided) 9840670517 ksm@mssw.in

Master of Social Work (Self Finance) A 9445945900 kbinian@mssw.in
Master of Social Work (Self-Financed) B 9840580971 prof.damen@mssw.in

Master of Social Work (Dlsablllty & 9003257813 jESUin@mSSW.in
Empowerment)
M.A. Human Resource Management 7502045805 hemakumar@mssw.in

M.A. Human Resource &

o 9710738384 venkatesh@mssw.in
Organizational Development
M.A. Development Studies 9894190530 moses@mssw.in
M.A. Sacial Entrepreneurship 9444610146 arasi@mssw.in
M.Sc. Counselling Psychology 9841616140 kalyanikenneth@mssw.in
M.Sc. Family Counselling 9677035181 hannahjohn@mssw.in
Bachelor of Social Work 77088756561 sudarmathy@mssw.in
B.Sc.Psychology 9843792610 madhuri@mssw.in
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Annual MCJ Award



Madras School of Social Work
No 32, Casa Major Road, Egmore, Chennai - 600008

General Enquiries : +91 - 44 - 28195126 / 28194566
(10 AM - 4 PM) 28192824

E-Mail Support ~ : admissions@mssw.in




